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Internet

SMTP

Mail Delivery Agent (MDA) Mail Delivery Agent (MDA\)
Mail Transfer Agent (MTA) Mail Transfer Agent (MTA)

Mail User Agent (MUA) Mail User Agent (MUA)
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©BepMeLl An3anH BUpycbIH XaMraanant SGB barraamxk 6a Heeunenrt
BYX TOPNWIAH O3Nr3LHHH X3MK3I3H A-M3iin CepBep 433D CYYPHICaH 5GB MM3IiN XaarananTaac ragHa TaHb
KWNnaxa. Ta rap yrac, Taoner, BWPYCHBI 3CP3r Nporpam TaHs! INbox-T W-M3ANYYA 30pHyNanTbiH HESLMIH
KOMMBIOTEP33C AMAP Y4 acyyaanryi HalOBapTal XaMraanaxaac ragHa CEpBEPT Xaaranaraax Tyn vyxan
ALNrMaX OONOMKTOR. BMPYCT3N haiin TaTaxaac CIprUinHa. M3N33 X3333 4 angaxryi.
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Kanexnap A33p axnaa Tensensx,

Brermen. nara anjarnaxryi 6a 24 COLUMAN OP4MHI X3ParTai M3g33nnas

Tamaarnan xetnex, IEDEI’J’IEI"-IHHH

L[ArWIAH TACANAANTYA AWNnaraar Taia LYY/, TYr33X, COLIWAN CAUTYYaTaN

XYDT3H3 Oyprran yycrax, Social Gonomxyyarau XONBOTIOX GONIOMATOM




BEN3MBIeNIMNT ABUTBGI@KXKO MXKXT (

Stay signed in

Sign in




Webmail.taubigoMdH.mn X a AT py y
X aH fgaak r 1 a X

Webmail . TaHbgoMamH. mn

XaHpantTaap XaHpgaX awWwur

Ce@B A33pP X a/mreagn aramaaxp

Xagagrananngyr awynroan roa Y
VI .
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@ Secure | https;//webmail.testmn/3

Portal Mail Address Book Calendar Tasks

psuite/#!&app=io.ox/mail&folder=defaultd/INBOX Y Tfr‘ :

Search... Q Compose *® & /A [ Settings View »
My contact data
& Inbox = Select all sort by »
B Drafs
, = WordPress [Mice Mongolia] Your site has updated to WordPress 46.7 Help 6:12 FM
4 Sentobjects _
Getting started
@ Spam B4 WordPress [Mice Mongolia] Your site has updated to WordPress 46.7 ) . 12:29 PM
Guided tour for this app
B Trash 4
= WordPress [Cheap home cleaner in bondi Cheap home cleaning in eastern subur 4:45 PM
» @ Archive Apout
B4 WordPress [Mice Mongolia] Your site has updated to WordPress 46.7 2:16 PM
¥ My folders .
= Sales Department Registration of testestsetset mn for 1 year Sign out 1:43 PM
Add mail account
= Datacom Deletion of Single Domain Linux Hosting (USA-TX) for dnssec.mn 9132017 5:41 PM

Mail quota _ . o o |
pA Natarom XXK Cancellation Request Confirmation 9132017 5:37 PM

Datacom Completed: addition of Single Domain Linux Hosting (USA-TX) for dnssec.mn 9132017 215 PM
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INbOX: DH I XXVA\C PA KA MT I VIHWMAUCIBMI U 1Y VTODBEKATP Y Y T H a
Appointments: K a e Hipaa aH[® FTOHM I SXTWIS@IDEIH 3 X PE 3T T
yaoaxryhmu

bo@xpumiancaHY PO A.XO

Tasks: Tasksx 3 CO23rT @ X NTAEAN1 6 B D @OTIO I XPYE D a KB U X
EcCTao AN AT caapp O /LHO

Birthdays: AddressBooka]a FJ@Alaaponadryaxrayimy yecypmrasaaygp T T
CawNycTrooxtomMxBirindaysx s cap3aypgax b pno®ep cesgHp nxmap y )
MHT 3 cCTH® WY YayYIMY V C T IO XP3A3P laimrma o oyiiAoo

N-M 3 /B y Y naaBxtaoam AddrasaBook g 3 3 p M A aCro/Harxawe 1@ u. n

Facebook & Twitter: T aFacebook6 o 1 dwitter a WK r N HHawM3 U 1 T UAYTY
X0NnNob6odMpoBCcH® ap Bawebookb 0o nbwmiterc apygp axa apgn®doa
Haffa3 aa®dyewymy Na3ar YHMUKBP NYOAXO MXKXT O U
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Portal Mail Address Book Calendar Tasks ] (2] — Dx

Basic settings

Accounts Basic settings
Advanced Settings (Beta)

Some settings (language, timezone, theme) require a page reload or relogin to take effect. Reload page

Paortal
> Mail Language English (US) v
Vacation Matice
Auto Forward Time zone +09:00 CHOST Asia/Choibalsan v
Filter Rules
Signatures Refresh interval 5 minutes v
Address Book
* Calendar Theme Default Theme v

Favorite timezones

] High contrast theme
Publications and Subscriptions

Error log Default app after sign in Mail v

Downloads

Automatic sign out disable v

¥ Automatic opening of notification area

¥ Show desktop notifications Manage permission now

My contact data ...

Change password ...




ABTPoO pBRa@X@Unpyynax

& & ‘ B Secure |https:f,f'webmaiI.test.mn,f'appsuite;‘#..&app='||:|.nx,fsettings&fnlderwirtualfsettings;’ic:-.o:q'autc:-fnmard

Portal Mail Address Book Calendar Tasks 3 9 —

Bazic seftings

frs Auto Forward

Advanced Seftings (Beta)
Forward all incoming emails to this address

Portal
*  Mail
Vacation Notice |:| HEEFI d COpy of the message

0 Enavke

Filter Rules
Signatures
Address Book
v Calendar

Favorite timezones

Publications and Subscriptions
Error log

Downloads




N-m 3 IRole

Create new rule

Rule name

Rule 1

Apply rule if all conditions are met

Conditions

This rule applies to all messages. Please add a condition to restrict this rule to specific messages.

Add condition

Actions

Please define at least one action.

Add action

Process subsequent rules

Cancel Save




N-m 3 Role

M3 pYYJIHMHUT Ta 66PHITH X3PI3TIRIH/AII TAAPYYJIK TOXUPYYIax 00JT0MKTOM.

Congiions | Jaaen

Sender/From HM3ii1 wiarsry Keep Xaarajax

Any recipient MMDIiJ1 XYJI9H aBard Discard Yerrax

Subject Capunr Redirect to JlaxXuH YUIITYYJIHD

Mailling List b AT o e Move to folder HpcrH uMHIMIHIAT IIAJEKYYJIHD
To / ccC X3H pyy Reject with reason lanTraan x3/oK TaTrana3ax
Header NmaiianiiH ToJroi xacar

Envelope -to Ilyynan

Size X3OMKII

Content AryyJara

Current Date SAByyJican nar

Sender Address XYJ99H aBar4uiiH xasir




Sighaturey y c T 3 X
N Signatures

Advanced Settings (Beta)
JHIMIAH rapbIH yCar Edit |}
Portal
* Mail TaHe! Hap
Vacation Nati TaHe yTac
acation Notice Komnaue! Hap, xaar, yTac
Auto Forward ['3% M3T XyCC3H M3A33NN33 opyym¥ bonHo
Filter Rules
HTML rapuin yeor et @
Address Book
~ Calendar XVHOSTI3C3H
Favorite timezones TaHe! Hap
TaHb! KOMNAHWIA H3p
Publications and Subscriptions -
Error log o -
Downloads
Default signature for new messages Default signature for replies or forwardings
HTML rapbiH ycar v SHIMWIAH rapblH ycar v




N-M 2 hendelua nr a X

Umoriia header paap Oyxmii 1 M3I33J1371 aryyJaracan Oaidgar TyJa Xyypamv
HMOIJIIIC CHPTUIAIIIX 00JTOMIKTOM .

Test

NDOX

~ =B

Domain Administrator Magicnet 10:11 AM (51 minutes ago) -~ D

test

test laest test

Domain adminstrator
Magicnet ISP
Ar Mongol travel bair, 202 toot
Utas. 330017

TelFax 330017

& Raply
» Forward
Open chat with Domain Administrator Magxnet
Filter messages ke this
Prmt
Delete this message
Block "Domamn Admmistrator Magcnet

Report spam

Mark as unread
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H-MAWJI KJIMECHT MPOrpam CyyJarasxk amurjiax

O p UKICHM N b B M3 KN apm r M8 @utlook, Outlook
Express, Netscape, Mail, Eudora, Tunderbird / cyy nraamar n.
TOXMNO/THOOIMIN b NDEM PUNKAMD B AY VOoamampry vy
[ 9 CY3lelM

o S o S o = o=

Outlook 2016 Outlook 2016 Outlook 2016 Outlook 2016
Tips & Tricks Tips & Tricks Tips & Tricks Tips & Tricks
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UMAPapH&E epPBDPIOMHMb KOTIEPPNKS A B A N N&XaH.O0 ar
CepBIROIPMI NYIGCDBI Aa0AKWO/AARO/RID MNb DO P X
MMI KRB T.AMBIHKK O Mb IOTEXPMMD YO TTI ABRAXLEPBIP
O3 Yo T.XaDpoHREXm Ma a paaxura/va 3, &/ar H

(POPapH&E € P B BPVAMETID DBKIDH b KOTIE3PP A P @ BKC H bl
NapaaprempP A Ma nync 1.0Cerp BoespdpvMa ¥ 4 T cda H
KOMMNDb KAT3E3pPHNMa /A HX3 B 3 HyAC3TOS A a R a gy nmanar g
ban.gPOPT OXNMpPraopawm@emn b WP E@T aXxiyagam M r
HBEC E P HIDBYP1 O 3 OSTXBXOMPXMMOKO N ASOHIS b a 1 0§ N
ASBaBaf MBMNIIPKIBIPCO M I A I axianpladxyacad a m.g ar




AnXx amwm
hdzif 221 ¢ ho h ™ aAddaceolhbiHd Manual setbp”

T

additional server typesm o e 0 e 0

T

Ldd Account -

Awuto Account Setup
Manual setup of an account or connect to other server types.

l:::l Email Account

Your Manmie: | |

Exarmple: Ellenn &Adams

Email &Address: | |

Example: ellen@mcontazo.com

Passwward: | |

Rebype Passwword: | |

Twpe the password yvour Internet service provider has given waul,




Anxamw

POPorIMAPX a cr mnr COHT OX ©T H®6

Add Account =

Choose Your Account Type

i Office 365
Automatic setup for Office 265 accounts

Email 2ddress:

Example: ellen@contoso.con

Advanced setup for POP or IMAP email accounts

() Exchange ActiveSync

Advanced setup for services that use Exchange ActiveSync

<Back || mext> ]| | canca | | Help




AnNXxam

POPOoniMAPa nb a.praap

Add Sccount e

POFP and IMAP Account Settings
Enter the mail server settings for yvour account.

User Informaticm Test Account Settings

Your Mame: ||_|3,,|:;| | We recommend that yvouwu test yvour account to ensure that
the entries are correct.

Email Address: |2<'3|::|3rj13rl-—| |

Server Information
| Test Account Settings ...

Account Type: (=l ] =] .
Incoming mail server: Ipnp.TaHu,ﬂ,nMaﬁH.mn l lI ﬁu:!:l?cr;::t:lica“y test account settings when Hed
Dutgoing mail server [SPATF): |5mtp_TEHH'ﬂ.ﬂMEﬁH_mn | Creliver mew messages to:
Logon Information @ MMew Cutlook Drata File
User Mame: |:-:'3|::|3rj13rl-| | i:::l Existing COutlook Crata File
| EBrowwse

Passwword: | e o o T e e e A

Eemember passwword

| MMore Settings ... |

<gack || mext>= | | canca | | Help |




CaHamMxX

X2 PBT9aBH B AT € pyHMenTy nyig @ @ Jx oavm 4l8P) T a HeLB p C |,
CVY /NIXA 3 BVPB ALY YVXO P U MBMOIAP O POy 3 Ura Prif B t
TOXUoOnNmxiaBMkovMnanwmmwaiolapaerpBepadmmamB
X3pPa.rtTanu

Magicnet: Outgoingmail server(SMTP). smtpmagicneimn
UlusNet : Outgoingmail server(SMTP). smtpunetmn
Univision :Outgoingmail server(SMTP) smtpunivisonmn
Outgoingmail server(SMTP) smtR.univisonmn
MobiNet: Outgoingmail server(SMTP) smtpmobinetmn

Tanbr SMtp cepep .  us2.smtp.mailhostbox.com
" " epopecepBep:  Us2.pop.mailhostbox.com

-




More settinggg 2 3 p

Server

Anx aw

AOpmdami ngaBer“viiyw adout g o i

requil recsX lapndemtuu cad X WOXY YV 1 H

Internet Ermail Settings

Seneral Chutgoing Server adwanced

@gse same settings as my incoming mail server

l:::ll__-::-g O WUsimg

Idzer Mame: |

FPazzsweord: |

BEemember passwwword
Feguire Securse Password SAuthentication [(SPAJ

l:::l Log o to incoming mail server before sending mail

el




Anx amm

JaMXMXPTO®M EaXbOMa Xy N as @0 FPOP- 110,
5 1Mmamnr a8 BMTP-25, 587

Internet Email Settings =

Seneral COwutgoing Server Advanced

Server Fort Rlumibers

Incoming server [(PCOP3): |E|f'3'5 | | Lse Drefaults |

[] This server requires an encrypted connection [SSLYTLS)

Duatgoing server [(SETFE:

s e the following twpe of encrivpted connectiomn: | S5LSTLS |--— ||

Server Timeaeouts

Short L Lormng 1 minuts

Crealivery

|__E-EI'I-I'E_'- a copy of messages on the server
BEemowve from server after | 14| |+|| days

|:| FRemowve from server when deleted from "'CDreleted [tems”

| K | | Cancel |




Account Settings =

oune 1 a ha n n

Email ~ DataFiles RSSFeeds SharePoint Lists  Internet Calendars  Published Calendars  Address Books

g Add... Iﬁgvﬁttingﬁ... ﬁSetasQefault XRemmre [agpen File Location...

File -> Account Settings> Account
Settings..H 3 B T .DptaaFAless o T 0 p
TawHiangawRagr anar ga
6ansLecationx acCB H B HIEA T a
XaaHan pOamHxapar.faHe:é

Mame Location

tuguldur@magicnet.... Chlsers\TugulduriappDataiLocalMicrosoftyOutlook’tuguldur@magicnet.mn...
tuguldur@magicnet.... Ch\Users\Tuguldur\Documents\Cutlook Files\tuguldur@magicnet.mn [1).pst

Select a data file in the list, then click Settings for more details or click Open File Location to -
display the folder that contains the data file. To move or copy these files, you must first shut Tell Me Mare.. C_\Use rS\Use r\DOCU mentS\OutIOOk

down Cutlook.,

Close




| [v] || = | Outlook Files KoMnbmbpep

Home Share YView X a .ﬂl [ a fﬁ@/“/l.ﬂ' a
Nn-M 3 U
— v « Doc.. » QOutlook... v | 0 I J
2 2 Tyxamn para Qanabir
arme
v 3 Quick access . nyﬂf‘iflpﬂa)K aBCf}‘aaP
B Deskt tuguldur@magicnet.mn (1) OOPHHH HMINJIII
=eep HeeleJ:K 0aiiraa Xxipar
; Downloads IOM .
et
ggl
> fam Onelrive
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JLg006 anmaa — maccBOpABIH ajijaa

JLg003 anmaa — cucTeMuiiH ajgaa

JUndelivered Mail Returned to Sender / 550.5.7.1/ anmaa

JIP xasar Blacklist-g opcon acoxuiir manrax /mxtoolbox.com/

JCepsep g39p Om0KI0TACOH Aeaxuur manrax . / windows firewall ,
telnet xuitxk y33x , tcptrace.exe /




Ca"amx

Be0 u-maitnuiin xsMmxd3 - SGB

JAttachment ¢aiin xamxka3 (body , subject , attachments) - 30mb

JIlarT 100 uMaiir uar?3x 00JIOMXKTOH . (HAT JoMalHTal Oyx
X3PIATIIATY)

JUnrasr4a Too (cc , bee)— 50




M1 tol @ dzt dzig RIGE00AzH © i 2
h Odzls ¢ OO dz

“HY yWir 3@ abd0 /1 0 XaYHUTUM NG @ B P O @AVHK 3 B D/TI0HHA U T B N KA X
3 CBX3y/B WiBHL 3 ama nmnaal/gar

“Hy yyur s gyBaabgeedeHp B @WMp TTr A8 Y Y ERBIY WLRA WU T N

STy X amNd X A& SPITY WO BT PXROXDAMG/YIIO X 6 6 XeaM¥l Bap o &B,
keyloggerf apa@ g y JTQOaBH 1 YWIPALBHI O\ 1T rmapaosrfc M doaaHIxa
HY WL B9 CRaAamMmODAHBPC BEHAAXWMHMIT. A3 HS3

“Phisingx y y max apX aapPpyyAgyeT oy ynax

CXIPIATNIMIMMI XTUYWUHA NT 33T XMAMMEHO NOTHYy X aXN B PIT N
X amaap a iaryaynpr aakuyiivi SHseHB TP e pbecy X OW P T, X a, Iy yyurm e |
HY YM3 03 9 nananynyr6 a aeker exeyogy p 89O Cc aXDBIIO @ K 6 T /I
XOPpThawm Ny .y y BNRIXT




JKummmn

X3pANIdrd eepuiH HYYI YD alllMIIax OyH XxeTed a33p xajarancan oaiaar. (mozilla , chrome
I'DX MOT)

Mozilla xeteu : Options - Security — Saved logins npcana xaaranarjacan Oanjaar.

Chrome : Settings — Manage Password x3cart Oyp maccBopayya xajarajiarjacaH Oanjar.

Sawved Logins

Logins for the following sites are stored on yvour computer:

S5ite e Ulsermame l ast Changed =
B httpo 10201 7.102.105: 9001 I G 16,2017
B httpes 1021 7.108.105:9003 I 9 16,2017
g http:s dashbeoard. haruulzangi.rmn _ S 18,2007
) httpssSSloginumicrosoftonline.com _ 91 572007
) httpssSSloginumicrosoftonline.com _ Q27,2007
ﬂ http s wwwwww . Ffaceb ook, corm S D 20T
=]

= Fermowe Aldl Irmmport... Show Passwwords



Router Passwor

LINKSYS®

A Division of Cisco Systems, Inc. Fimmuware an: 1.04.06

EtherfastE Cable/DSL Router BEFSR:H

Setup . .Applicat_inns

R Gaming Admirllistratiulll Status USERN AME . admin

PASSWORD : admi
admin

Internet Connection Type

Command promt (cmd ) =>
ipconfig /all
(192.168.1.1 default gateway)

RS (1or zing [el)
PRTF

Heart Beat Signal Time |5 Min.
L2TP —

~KEEp AIUET REGRTPETON [30 Sec.

Optional Settings
(required by some ISPs)

Host Mame: |

http://192.168.1.1

Diomain Mame: I

MTLE  Enable * Disable Size: 1500
Hetwork Setup
Router IP Local IP Address: Ilslz . Ilsa . Il . |254
Subnet Mask: [ze5.ze5.255.0 x|

Hetwnrk Addrece




Webmai | . TaHbBAOMI3 N EL

@ Secure | https;//webmail.testmn/3

Portal Mail Address Book Calendar Tasks

psuite/#!&app=io.ox/mail&folder=defaultd/INBOX Y Tfr‘ :

Search... Q Compose *® & /A [ Settings View »
My contact data
& Inbox = Select all sort by »
B Drafs
, = WordPress [Mice Mongolia] Your site has updated to WordPress 46.7 Help 6:12 FM
4 Sentobjects _
Getting started
@ Spam B4 WordPress [Mice Mongolia] Your site has updated to WordPress 46.7 ) . 12:29 PM
Guided tour for this app
B Trash 4
= WordPress [Cheap home cleaner in bondi Cheap home cleaning in eastern subur 4:45 PM
» @ Archive Apout
B4 WordPress [Mice Mongolia] Your site has updated to WordPress 46.7 2:16 PM
¥ My folders .
= Sales Department Registration of testestsetset mn for 1 year Sign out 1:43 PM
Add mail account
= Datacom Deletion of Single Domain Linux Hosting (USA-TX) for dnssec.mn 9132017 5:41 PM

Mail quota _ . o o |
pA Natarom XXK Cancellation Request Confirmation 9132017 5:37 PM

Datacom Completed: addition of Single Domain Linux Hosting (USA-TX) for dnssec.mn 9132017 215 PM




HTTP 6 o nl@THPS

HTTPSO y 1@M3n o p TTO®XN p YWeIL aH

Encrypted Application Data: 6693086d85ab75e000be2a678b9deddbal414focT619a595. ..
¥ 55Lv3 Record Layer: Application Data Protocol: hitp

Content Type: Application Data (23)

Version: S5L 3.0 (©x8300)

Length: 32

Encrypted Application Data: 8clblcbh6eb@e5fdf960eca5ad59t444bbebbolf8f46c14d3. ..

K. Bl..

@060 86 58 e2 80 42 31 d7 17 03 00 00 20 HeSlsias|s ... AR
CLylaob 80 5T df 96 @e ca 5a 55 9T 44 4b be 6b 61 TEQNM.. ....Z U.DK.ka.
CLET4 6c 14 d3 34 72 89 56 7a Ba fc 52 L..4r. « . R

HTTP6 y 189N o p TTO®MXU p YW a H

bOO0 ©0 00 00 00 B0 B0 G0 00 OO0 0O 00 OO @8 @0 45 00 ........ ..., E.
00186 00 3e bl e® 40 00 40 06 8a d7 7f 60 0@ 01 7f @@ .>..@.@. ........
0020 00 01 22 b8 b0 9c 93 be bb ad 4 83 36 bl 80 18 .."..... PN | FR

3@ 01 56 fe 32 @0 00 01 @1 ©8 0a @0 67 15 19 @@ 67 .V.2.... ...Q...Q

LECECLICTNT9 75 20 62 62 61 20 64 61 61 Myu bna daa




SSL cyynrax

hedu.mn S
Dashboard 3 Settings « Eerﬂca&g?éﬁjadt&fﬁg
r Add User
[E] AccountOv{ , adg Bulk Users —1 Actions
Status r Add Forward Only Account » Add User
Users / Accountd » Manage Users / Accounts » Add Forward Only Account
Mailing Lists: » Export Users » Manage Usears / Accounts

» Add Mailing List
» Manage Mailing Lists

Accounts Over @ * Manage Domain Aliases

")

» Manage Catch-All

Suspended
Blacklisted Mailing List
Catch-All v Add Mailing List

¢ Manage Mailing Lists

Webmail Settings

Install Certificate

Mail Settings

apINg aAIeIAU|

» DMNS Configuration




J1P3p aypbacaH 3pCadayy/l rapraxryv 0aix Hb ©0pHUIH
00JIOH OalryyijIarblH ©MHOOC Xapuilax Oalraa XyH
OyXHMH IJaxuM opuuH 10X Y YPOI Oaiinar.

MaHalixaac majaTraajaaryy Xy4uH 3YHICA3C 00K
HYYII Y33 ajjicaH O0alraa HOXLOJ1 MaHAKUX
Xapuylyjiara XyJg3XI'yu IATMUT aHXaapHa vy.




M1 te R 10IdzH dzOtE [ HSEROS: P

XopoarpmapwouTadyynapceodn U ar
anpanrynompaoaHgaHgaxXx HanlnagBapT
boeregpnranxXnauNayur>x@ Xapo XRAHE anT:
M3 1 9 3X/ladHarpa H a

CepBIBMmM/PORY pambéka n.gkamr mix 33
XOHOBanmpmRAY/XYyraaaaax canNyyannb
TOAOOP X OXMYIHOKD@O 1A D T

ANBGoMOWp RaildTatHA P Y YXITBXI.T T I3 U
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NOMAOVHUAYUNANT 3BB017

TEXHO/N OMB1R065/241IAT/

FACEBOOKX Y Y 1 A:GMAGICNET ISP
WWW.MAGICNET.MN, 36BJIOTO6 BYJIAH
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